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 Loading an Icon File
Power Icon v1.0 can extract icons from 4 different file formats, including icon files (.ICO), icon 
libraries (.ICL), dynamic link libraries (.DLL), and executable programs (.EXE).

There are four ways to open an icon file:

1. Use File/Open or click the  button.

This is the "standard" method of opening files, and perhaps the easiest.    Simply select 
File/Open from Power Icon's menu bar, browse for or type in the filename you want, and 
click OK.

2. Drag and drop the desired files from the File Manager onto Power Icon.

One of the major advantages of using drag & drop to open the files is that you can easily 
open as many files as you want.    To see how this feature works, try the following test:

1. Start both Power Icon and the File Manager.    Make sure that you can see part of 
the Power Icon window--it's ok if File Manager covers most of it up, as long as 
you can see part of it.

2. Using the File Manager, go into your Windows directory and select about five 
executable (.EXE) programs.    You can do this by holding down the <Control> 
key while you click on each file.

3. Once you have several selected, click on one of the highlighted programs, and 
drag the cursor until it is positioned over the visible portion of Power Icon.    

When the cursor looks like , you can release the mouse button and "drop" the 
files onto Power Icon.

4. Power Icon will then open each file individually, as a seperate window.

3. From the File Manager, double-click an *.ICO, *.ICL, or *.DLL file.

When Power Icon is installed, it will automatically associate *.ICO, *.ICL, and *.DLL 
files with itself. itself.    This allows Windows to "recognize" these files and make them 
easily viewable from the File Manager and other utilities.

4. Specify the file(s) using command line paramaters, when Power Icon is run.

When you run Power Icon, you can use command line paramaters to specify as many 
files as you want to open.    For example, from the Program Manager, you can select 
File/Run from the menu.    Then, in the "Command Line" field, type:



powerico c:\windows\progman.exe c:\windows\moricons.dll

This will launch Power Icon with both of the files "progman.exe" and "moricons.dll".



 Copying an Icon to the Clipboard
To copy an icon to the clipboard, perform the following simple steps:

1. Open the icon file that contains the icon you want to copy.
2. Select the icon by clicking on it.

3. Select Edit/Copy, or click on the  button.
4. Choose the background color.    This color will show through in the icons transparent 
areas.

Special note:
There is no clipboard format which specifically allows the transfer of icons between applications.
As such, when an icon is copied into the clipboard, it becomes a bitmap graphic.    This is useful 
for such things as documenting programs, or pasting icons into graphics... but cannot be used to 
change another application's icon.    At this time, Power Icon does not support modifying or 
creating icon files, and will not allow you to paste an icon into an open icon window.



 About Limelight Media, Inc.
Limelight Media, Inc. is a multimedia publishing company which was founded to produce 
extremely high-quality titles at a very reasonable price.    Our company hires only the best 
programmers, with outstanding skill and unsurpassed dedication to our cause.

If you have any question about our products or suggestions for new products, please call us.    We
are always eager to talk about the industry and potential opportunities.



Copyright Notice and License Agreement
PowerIcon v1.0 and its accompanying documentation are Copyright © 1994, Limelight Media, 
Inc.    All rights reserved.

The use and copying of this product is subject to a license agreement.    Any other use is 
prohibited.    No part of this software or documentation may be reproduced, transmitted, 
transcribed, stored in a retrieval system, or translated into any language in any form by any 
means without the prior written consent of Limelight Media, Inc.

Federal copyright law permits you to make a backup of this software for archival purposes only.  
Any other duplication of this software, including copies offered through sale, loan, rental or gift 
is a violation of law, and subject to both criminal and civil penalties.

You may use this software on a single computer that you own or use.    Under no circumstances 
may you use it on more than one machine at a time.    You may make a copy of the software for 
backup purposes, provided that you reproduce and place our copyright notice on the backup 
copy.

This software is non-transferrable.

Disclaimer

Although Limelight Media, Incorporated believes this program performs in the documented 
manner, the program is provided 'as is' without performance warranties of any kind, either 
expressed or implied, including, but not limited to the implied warranty of fitness for a particular 
purpose.    The entire risk as to the quality and performance of this program is assumed by you.

In no event shall Limelight Media, Inc., or its owners, employees, dealers or distributors, be 
liable for lost profits, data or information of any kind or for consequential, special, indirect, 
incidental, punitive or other damages that may arise through use of the product licensed 
hereunder.

U.S. Government Restricted Rights

The software and documentationa re provided with restricted rights and are proprietary to 
Delrina Technology Inc.    Use, duplication, or disclosure by any state, local or federal 
government in or of the Unites States of America is subject to restriction as set forth in 
subparagraph (c)(I)(iii) of the Rights in Technical Data and Software--Restricted Rights at 48 
CFR 52.227-19, as applicable.
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For information on how to use Help, press F1 or select Using Help from the Help menu.



Edit Menu

The Edit menu provides commands to undo edits, access the clipboard, and to delete text.

Undo Undo the previous operation.
Cut Delete selected text and move it to the clipboard.
Copy Copy selected text to the clipboard.
Paste Move text from the clipboard to the current document.
Clear All Delete all text in document.
Delete Delete selected text.



File Menu

The File menu provides commands for creating new files, opening existing files, saving files, 
printing files, and exiting the application.

New Create a new, untitled, document.
Open Open an existing file.
Close Close the current document.
Save Save the current document if its contents have changed.
Save As Save the current document under a new name.
Exit Exit powerico application.



Search Menu

The Search menu provides commands to find and replace text.

Find Find a pattern of text.
Replace Replace one pattern of text with another.
Next Find and/or replace the next occurrence of text pattern.



Window Menu

The Window menu provides commands to control the position and layout of application's 
windows.

Cascade Resize and position all windows in an overlapping pattern.
Tile Resize and position all windows in an non overlapping pattern.
Arrange Icons Align all iconized windows along a grid.
Close All Close all windows.



Copying Text

To copy text to a document from the clipboard, position the cursor at the desired insertion 
point, and choose Edit|Copy from the menu.



Deleting Text

To delete text from a document, select the text, and choose Edit|Cut or Edit|Delete from the 
menu.    Cut will put the deleted text in the clipboard, and Delete will simply delete it.



Exiting

To exit the application, choose File|Exit from the menu.



Edit Window

The edit windows in this application allow reading, editing, printing and saving text files up 
to 64K characters in size.



Drag/Drop from the File Manager

A file can be opened into an editor in the application by dragging the file from the File 
Manager, and dropping it on powerico's main window.



Edit Copy Command

The Edit|Copy command leaves the selected text intact and places an exact copy of it in the 
clipboard.    To paste the copied text into another document, choose Edit|Paste.



Edit Cut Command

The Edit|Cut command removes the selected text from your document and places the text in
the clipboard.    Choose Edit|Paste to paste the cut text into another document. The text 
remains selected in the clipboard, and can be pasted multiple times. 



Edit Paste Command

The Edit|Paste command inserts the text currently selected in the clipboard into the current 
window at the cursor position. 



Edit Undo Command

The Edit|Undo command restores the file in the current window to the way it was before your
most recent edit operation.    Undo inserts any characters you deleted, deletes any 
characters you inserted, replaces any characters you overwrote, and moves your cursor 
back to a prior position.



Edit Clear All Command

The Edit|Clear All command deletes the entire contents of the current document.    Use Edit|
Undo to restore the contents.



Edit Delete Command

The Edit|Delete command deletes the currently selected text from the current document.    
The text is not placed in the clipboard.    Use the Edit|Undo command to restore the text.



File Close Command

File|Close closes the currently active window.



File Exit Command

The File|Exit command exits powerico.    If you've modified documents without saving, you'll 
be prompted to save before exiting.



File New Command

The File|New command opens a new, untitled document, and makes it the active window. 
The application prompts you to name untitled documents when they are closed.



File Open Command

The File|Open command displays the Open a File dialog box so you can select a file to load 
into a new document window.    You can also create a new document by naming a file that 
doesn't currently exist.



File Save Command

The File|Save command saves the document in the active window to disk. If the document is 
unnamed, the Save File As dialog box is displayed so you can name the file, and choose 
where it is to be saved.



File Save As Command

The File|Save As command allows you to save a document under an new name, or in a new 
location on disk.    The command displays the Save File As dialog box.    You can enter the 
new file name, including the drive and directory.    All windows containing this file are 
updated with the new name.    If you choose an existing file name, you are asked if you want 
to overwrite the existing file. 



Search Find Command

The Search|Find command searches the current document for a text pattern.    The command
displays the Find dialog which controls the search process.    Options in the dialog determine 
whether only whole words are to be matched, whether the case of characters is significant, 
and whether the search should be conducted forwards or backwards through the document.  
As each match is found, it is highlighted in the document.



Search Next Command

The Search|Next command repeats the last Find or Replace operation.



Search Replace Command

The Search|Replace command searches the current document for a text pattern, and 
replaces occurrences of the of the pattern with new text.    The command displays the 
Replace dialog which controls the search/replace process.    Options in the dialog determine 
whether only whole words are to be matched, and whether the case of characters is 
significant.    The dialog is also used to specify the pattern to search for, and the text to 
replace occurrences with.



Window Arrange Icons Command

The Window|Arrange Icons command arranges all iconized windows into rows along the 
bottom of the application's main window.



Window Cascade Command

The Window|Cascade command arranges all document windows from the top-left position of 
the application's main window so that the title bar of each is visible.



Window Close All Command

The Window|Close All command closes all document windows open in the application.



Window Tile Command

The Window|Tile command arranges all document windows side-by-side in a non-overlapping
pattern.





The Toolbar
The Toolbar is a row of buttons at the top of the main window which represent application commands. 
Clicking one of the buttons is a quick alternative to choosing a command from the menu.    Buttons on 
the toolbar activate and deactivate according to the state of the application.

Button Action Menu Equivalent

Create a new document File|New

Locate and open a file File|Open

Save the file in the active window File|Save

Cut selected text to Clipboard Edit|Cut

Copy selected text to Clipboard Edit|Copy

Paste text from Clipboard Edit|Paste

Undo previous editor action Edit|Undo

Search for text Search|Find

Repeat last Find or Replace operation Search|Next

Display help file contents (None)



Windows Keys
Cursor Movement Keys
Dialog Box Keys
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Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Pape Up or Page Down Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

Tab Moves from field to field (left to right and top to bottom).
Shift+Tab Moves from field to field in reverse order.
Alt+letter Moves to the option or group whose underlined letter matches 

the one you type.
Arrow key Moves from option to option within a group of options.
Enter Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

Esc Closes a dialog box without completing the command. (Same as
Cancel)

Alt+Down Arrow Opens a drop-down list box.
Alt+Up or Down Arrow Selects item in a drop-down list box.
Spacebar Cancels a selection in a list box.

Selects or clears a check box.
Ctrl+Slash Selects all the items in a list box.
Ctrl+Backslash Cancels all selections except the current selection.
Shift+ Arrow key Extends selection in a text box.
Shift+ Home Extends selection to first character in a text box.
Shift+ End Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

Shift+F1 Changes the pointer to  so you can get Help on a specific 
command, screen region, or key. You can then choose a 
command, click the screen region, or press a key or key 
combination you want to know more about.
(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






